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Discover ProfiSignal Go

Measurement data acquisition and evaluation

Export measurement data to other programs

Trend diagrams, characteristic curves, logic diagrams

Continuous data acquisition and evaluation of long-term data

Measurement series data recording using predefined start/stop conditions

Manual start/stop for data recording
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1 Product overview

Dear Customer,

In contrast to other products, which provide only basic measurement data
acquisition functions, ProfiSignal Go gives users a comprehensive range of data
acquisition and evaluation tools as well as access to historical data and historical
data evaluation. In our view, ProfiSignal provides the simplest, fastest and most
flexible way to fulfill such requirements.

The Online Analysis section shows the quickest way to visualize measurement data
and to display the data as trends.

Upgrading to Basic or Klicks

You can upgrade to ProfiSignal Basic or ProfiSignal Klicks at any time.

ProfiSignal Basic is recommended when multiple processes are to be visualized.
ProfiSignal Basic also provides static reporting functions.

ProfiSignal Klicks includes ProfiSignal Go and ProfiSignal Basic. ProfiSignal Klicks
enables the automation of measurement procedures, test stands and processes as
well as dynamic reporting functions.

3

Info:

The F1 key provides context relevant help, i.e. specific information on the
system features currently being used.

2 ProfiSignal Go manual
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Online Analysis offers many unique features. The most important of these is the
well-known and and fastest method to visualize measurement data on a screen,

and the simplest method of analysing measurement data.

Online Analysis can run parallel to other system operations without affecting their

functioning.

& Profisigna - (Ge) - Delphin Technolegy AG
Help

File View Settings Window

l2g2 = 6H ([FHa|

& Online Analyse - Triangle

Project management
-G MesFiles

1) Fomular

=+ Online Analyse 1

B Testkanile &
g sine
By Temperatues
[y Tiiange

O & Online Analyse - Sine

H 9 I online Analyze - T

H ¢ 3 online Analyse - Testkanale A

H ©| = online Analyse - Online Analyse 1
{| Online Analyse Settings  Window

EOS&E8

=8 B (=)

‘rt-diagiam w1l

channel filter | show all hide all

Color |V Name Walue Un

10.0

i

v D Test channel sawl -5.28

1A

\

{ L
-10.0
gir
A H 28,000 sec 30,000 sec 31,000 sec 32,000 seq
A 19.08.2010 12:35 . .
4317
Fﬁ A # ety UM EOE 00 fm Y
F—" ——Hv v & WoRen 2 &n
G
L3 AnalyseRecord =
Lol File name status time: data
A e

| Local time (PC)

Online Analysis is typically used for: servicing, in mobile applications, fault
detection, start-ups etc.

The following functions have a tried and tested record:

e Options for trend charts (Yt), characteristic curves (Yx) or logic diagrams.

e Online Analysiss can access historical data saved in the background.

e Measurement series can be automatically generated with predefined start/stop

conditions.

e Measurement series can be manually started/stopped.

e Any number of Online Analysiss can be set up. A diagram is set up for each

Online Analysis.

e Each Online Analysis is automatically assigned the user-defined configuration.
Configuration data can be stored and used as a default for other Online

Analysiss.

ProfiSignal Go manual
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e Multiple Online Analysiss can be run simultaneously.

¢ Individual Online Analysiss can be opened as required, the measurement data
acquired and evaluated.

e Each Online Analysis can be assigned an individual name.

4 ProfiSignal Go manual
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1.2 ProfiSignal product family

1. Overview
e ProfiSignal Go is first-level online analysis software for measurement data
acquisition and evaluation.

¢ ProfiSignal Basic contains ProfiSignal Go and provides operating and monitoring
objects as well as trend diagram and characteristic curve functions.

¢ ProfiSignal Klicks includes ProfiSignal Go and ProfiSignal Basic. It is equipped with
the Klicks interactive, technician programming language that enables the
automation of processes.

ProfiSignal Go can be upgraded to ProfiSignal Basic or ProfiSignal Klicks.
ProfiSignal Basic can be upgraded to ProfiSignal Klicks
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Online Analysis offers many unique features. These include the fastest and well-
known method for visualizing measurement data on the screen as well as the

simplest method for analysing measurement data.

Online Analysis can run parallel to other system operations without affecting their

functioning.

Online Analysis is therefore ideal for servicing, mobile applications, fault detection,

start-ups etc.
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Process visualization (known as ProzessVisu or Visu for short) is the software
module for process operation, observation and monitoring.

Users can easily generate their own visualization views using operating and
observation objects as well as trend diagrams and characteristic curves.

Visu is especially suited to experiments, testing procedures, test stands and
production processes. Data and usage information can be acquired and evaluated
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1.2.3 ProfiSignal Klicks

ProfiSignal Klicks includes ProfiSignal Go and ProfiSignal Basic.

ProfiSignal Klicks enables automation of experiments, testing procedures, test
stands and production processes.

Klicks is a language developed for technicians, engineers and scientists that
requires no IT specialist.

Klicks is a unique product because

e it requires no learning

no lengthy familiarisation is required

there is no requirement to learn a programming code or instruction set

no typing up of program code is necessary

programming maintenance is simple

no specialist IT skills are required

Operation is extremely user friendly with programming instructions being selected
from context menus. The typing in of programming code or the learning of a
programming language is therefore unnecessary. This is a major difference to
conventional programming languages.

ProfiSignal Klicks programs can therefore be said to be configured rather than
written as in conventional programming techniques.
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1.3 Content overview

1. Software activation

Activating the ProfiSignal license. ProfiSignal Go comprises two programs: the
DataService Configurator and Profisignal Go.

2. ProfiSignal Go - Outline

The hardware manuals provide information on hardware configuration. Configuration
is a prerequisite for working with ProfiSignal.

Start the program via the desktop icon.
Integrating ProfiSignal into a network.
General settings for individual requirements.

Adapt ProfiSignal Go to your requirements when you wish to have alternatives to
the default settings.

3. Online analysis

Online analysis provides acquisition, evaluation, storage and export of
measurement data.

Any number of Online Analysiss can be set up. A diagram is set up for each Online
Analysis. This can be a trend (Yt-diagram), a characteristic curve (YX-diagram) or
a logic diagram.

Each Online Analysis is automatically assigned the user-defined configuration.

4. Trends, Yt-diagrams

Learn how to operate, configure, assign channels and evaluate measurement data
using trend diagrams.

A trend can process large numbers of channels. Specific channels can be accessed
using a hide/show function.

Up to four axes can be used. Channels can be assigned to the individual axes.
Axes can be extended and compressed. Axes can be panned.

A trend diagram is assigned to an Online Analysis.

5. Storing measurement data from an Online Analysis
ProfiSignal Go enables continuous and batch data storage.

Data be recorded while measurement data files are being set up with start/stop
settings. Data records can also be set up with manual start/stops.

ProfiSignal Go manual 9
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6. Measurement data analysis
An operating and analysis mode is available in ProfiSignal Go during runtime.

The operating mode runs online and provides access to the the most up to date
data.

The analysis mode runs offline with online/offline switching available at the click of
the mouse.

ProfiSignal Go has an extensive range of analysis functions. The functions are
operated via toolbar buttons.

7. Appendix: Test channels
Test channels are channels that require no hardware.

When hardware is unavailable, test channels can be used instead of hardware
channels.

These enable functions such as sinus, square and sawtooth to be assigned to the
separate channels.

Test channels can be used to learn about the full capabilities of ProfiSignal.

Test channels are set up and configured within the DataService.

8. Appendix: ProfiSignal in networks

If you use the TopMessage or Expert hardware you have the option to integrate
the hardware and software into an existing data network via a LAN interface.

If you use the Expert hardware you can can connect the devices to a PC via a
USB and perform data evaluation on multiple PCs.

10 ProfiSignal Go manual
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2 ProfiSignal Go - Outline

Hardware manuals
The hardware manuals provide information on hardware configuration. Configuration

is a prerequisite for working with ProfiSignal. All documentation is available from the
start menu under:

Start/All Programs/ProfiSignal/...

This manual is based on the hardware manuals.

3

Info:

The hardware manuals explain:
e Hardware operation

e DataService installation

e USB or LAN connections

¢ Hardware configuration

Configuration data is permanently stored within the devices and therefore always
available at each restart.

ProfiSignal Go manual 11

© 2003-2011 Delphin Technology AG



PmﬁS@Gn Delphin

Techmology
Delphin hardware overview
Refer to the hardware manuals for detailed information
-t e R Y ey Yy TeTe
Message Series Expert Key L Expert Key C
Built-in model Tabletop, Wall mounting Built-in model
LAN USB, LAN USB, LAN
12 ProfiSignal Go manual
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2.1 Activating ProfiSignal Go

Activation of the ProfiSignal Go licence

Following installation and the first start of ProfiSignal, you will be prompted to
activate the the ProfiSignal licences. Activation enables permanent and full use of
the licensed software. Ignoring the activation procedure will prompt the issuing of
regular reminders. Because of activation time limits that have been set for security
reasons, we recommend that you carry out activation immediately .

The activation code for the procedure is available online via the internet, via
email, fax or post.

Activation set up:

Start ProfiSignal » Select the Help tab from the main menu W Activate licence

(following successful activation the menu option will change to Edit licence)

ProfiSignal Go manual 13
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The main dialogue for activation code input opens:
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Edit Licence
Edit Help

Manufacturer: Delphin Technalogy AG

Licenced faor: Delphin Technalogy AG
Modules
= o Modules

T Gol avaisble)

7 Device OC [ available)

gj OPLC Server [ available]

gj LabView | Limit of channels: 40, Online, awailable)

List of purchased Modules

[] Show éctivation keys

apply activation key

apply activation key field

D eactivation

OrderMa.: 111111
Lizence-File-1D: 1753
Licence-Date: 07.06.2010
Update until: 07.06.2093

Installationscodes
Code 01: FaFQA0E43

Code 02 D14C50423
Code (03 BATI02474

Code (4: E39B82DEE
Code 05 3AE537434
Code 05 AAFI24250
Code 07; 042032302

Code 08 040B1B441

Code 05:  1FB150420
Code 10; &3BC384E5
Code 11:

Code 12 EO7423000

Enter Activation Code(z)

Help “ Close

A. Online registration

This activation procedure runs automatically. Select Online-activation from the

main dialogue

Main dialogue¥» Online-activation» Activate now

B. Phone registration

Select Phone-registration from the main window. Dial the displayed telephone
number to request the code. Input the code in the relevant activation code field

(main dialogue). Confirm with Enter Activation Code(s).

Main dialogueW Phone-activation » Request code via telephone W apply activation key »

Enter Activation Code(s)

14

ProfiSignal Go manual

© 2003-2011 Delphin Technology AG



PrnfiS@ Go Delphin

Technology

C. Mail activation

Select Mail-activation from the main dialogue. Input the registration data into the
dialogue fields and confirm with OK. The activation code is then sent by Delphin
Technology AG. Enter the sent code/key in apply activation key field. Confirm with
Enter Activation Code(s).

Main dialogue®» Mail-activation > Sending of code/key W apply activation key W Enter

Activation Code(s)

D. Fax activation

Select Fax-activation from the main dialogue. Input the registration data into the
dialogue fields and confirm with OK. A fax is automatically generated. Send the fax
to + 49 2204 97685-85 (Delphin Technology AG). The sending of the activation
code is then undertaken by Delphin Technology AG. Enter the sent code/key in
apply activation key field. Confirm with Enter Activation Code(s).

Main dialogueW Fax-activation » Sending of code/key W apply activation key » Enter

Activation Code(s)

Licence extension

There is always an option to extend an existing ProfiSignal licence to include more
functions(refer to ProfiSignal-Product Range).

Delphin will then provide new codes/keys for any additional modules. Entering the
key via the apply activation key field and clicking Enter Activation Code(s) writes
the key to the licence file.

The new functions can then used following a ProfiSignal restart.

ProfiSignal Go manual 15

© 2003-2011 Delphin Technology AG



PmﬁS@Go Delphin

Techmology

2.2 Access via desktop icons

ProfiSignal Go comprises two programs: the DataSevice Configurator and Profisignal
Go.

) -s
=

ProfiSignal DataService
Configurator

Desktop icons for ProfiSignal Klicks

The DataService Configurator icon starts the program.

The ProfiSignal icon starts the measurement data acquisition software. Either Go,
Basic or Klicks can be installed.

DataService Configurator

The DataService / Configurator runs as a background program. It is called only for
hardware configuration or database set up.

ProfiSignal Go

ProfiSignal Go performs your measurement requirements in the form of Online
Analysiss.

16 ProfiSignal Go manual
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2.3 ProfiSignal in networks

There are a range of options for connecting measurement hardware to ProfiSignal:

ProfiSignal
Application A

ProfiSignal
Application B

DataService

ProfiSignal
Application C

Expert devices are equipped with an USB interface and a LAN interface.
Message devices are equipped with a LAN interface.

3

Info:
Information on using ProfiSignal within company networks is available in the

ProfiSignal in networks section.

ProfiSignal Go manual 17

© 2003-2011 Delphin Technology AG



ProfiSignal Go Delphin

Techmology

2.4 General settings

Access:
Edit mode / main screen/ menu bar W Settings » Global Settings W General tab

-

[ Settings @

General | Timezone I Bt e:-:pu:urt|

ConfigTree General

Textcolor . Drefault language | English -
B ackgroundcolor: |:| Log Ievel:

Show tree icons

Global alerting

Activate global alerting

ok | | Caneel | | Heb

ProfiSignal may be configured in many ways using the basic settings. For example,
the latest project file being worked on can be automatically reopened at a restart.

Fonts and colors can be adapted to meet individual needs.

18 ProfiSignal Go manual
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Online Analysis for acquisition and evaluation of measurement data.

Any number of Online Analysiss can be set up. Each Online Analysis generates a
diagram. This can be a trend (Yt-diagram), a characteristic curve (YX-diagram) or

a logic diagram.

Each Online Analysis is automatically assigned the user-defined configuration.

Multiple Online Analysiss can be run simultaneously.

Each Online Analysis can be opened as required, and measurement data then

acquired and evaluated.

You can assign a specific name to each Online Analysis.

The illustration shows multiple Online Analysiss, which can be accessed as

required.
@ ProfiSigna - (Go) - Delphin Technalogy AG [al&@][=]
File View Settings Window Help
lege = 0w ([Ha|
Project management @ Online Anzlyse - Triangle \?\lﬁ”?ﬂ
-] Mesfiles 0| & Online Analyse - Sine [oll@l=]
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L Testardes 1 9 =1 Online Analyse - Online Analyse 1 =R =
[ sine 1| Online Analyse  Settings  Window
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3.1 Test channels

Setting up test channels is described in detail in the Appendix: Test channels
section.

Test channels are channels that require no hardware.

When hardware is unavailable, test channels can be used instead of hardware
channels.

These enable functions such as sinus, square and sawtooth to be assigned to the
separate channels.

Test channels can be used to learn about the full capabilities of ProfiSignal.

Test channels are set up and configured within the DataService.

20 ProfiSignal Go manual
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3.2 The fast path from sensor to trend

Online Analysis is hallmarked by the simplicity of its operation. A minimum of effort
is required to get your measurement data displayed on the screen.

Just five steps to display measurement data as a trend!

S

Requirements:

You have already configured your channels or are using software channels as
described in the hardware manual.

Step 1
Start ProfiSignal via the desktop icon.

Step 2
Select Create new Online Analysis view from the symbol on the toolbar.

b1 ProfiSignal Go l o 2 |-

File View Settings wWindow Help

FEZ 208 (Ha
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Step 3
The following dialogue opens. Click the Yt-diagram button.

H Please choose: E@

Show diagram:

SN
Logk [

NS

P

s
Yot Colar 7

Cancel x ‘

Step 4
The following dialogue opens. On the left are the channels that you have activated

according to the hardware manual. You can select single or multiple channels to be
included in your Online Analysis.

Select the required channels (left) » Left click on Add » Confirm with OK

The channels will then appear on the right:

e Choose Channels - Online Analyse @
|Channe| Yalue | State |Name SizeValue | State
+ » Expert Key 100L PVC A Test channel sine -3.08 Ok
= M Software channels FHF B Test chanel rectangle -8.00 Ok
PVC A Test channel sing 3,09| 0k PVA C Test channel tiangle 5,60 Ok
FH: B Test channel rectangle 9.00|0k }-- [ Test channel sawtooth 360 Ok
PVA C Test channel tiangle B.60| Ok
I--- D Test channel sawtooth 3600k
Kl DI D]
Add Femove
Ok ] [ Canicel ] [ Help ]
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Step 5

The trend diagram opens automatically and displays the added channels. Using the
trend diagram is explained in the following sections.

6 Online Analyse - Online Analyse,
Online Analyse  Settings  Window

[F=3 E=R (5
EIEE @ =] “Yt-diagram il
Y1 channel fiIterI shaw all | hide al | ”
H H | T Color |V.. Name |Va|ue
10.0 ; ;

] 7.29
M | B Test channel rect: 9,00
M ¥ C Test channel tiarn 3,35
[ ] v D Test channel sawi 1,44

5.0+

0.0+

50+

=100+ -
21 ‘DDID seC ZZ,DDID s8C 23‘DDID seC 24,DDID s&C
08.08.2010 1247 4 | | ﬂ
e 4 L U N o I O g B v = BR B
.I"H'-PE £ i+ - ¥ > S X 8 IF Retum "R’I =1
R!( m|1n AnalyzeRecorder EI
File name status timne data
Local time (PC)
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3.3 Operation / observation of Online Analysis

Operation & observation is one of two modes within Online Analysis. The other
mode, described in the Analysing measurement data section , concerns the
analysis of data.

Operation and observation

Operation and observation takes place online, which means that the graphical
portrayal is being continuously updated with the latest data.

Analysing measurement data

Measurement data analysis takes place offline. This means that the graphical
portrayal is not being continuously updated with the latest data.

Measurement data can then be evaluated. The user can move backwards along
the time axis - a unique feature within ProfiSignal.
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3.3.1 Creating a new Online Analysis

Creating a new Online Analysis

t=1 ProfiSignal Go l o2 | ]

File View Settings wWindow Help

2EE =5 6@ (Ha

A dialogue opens with the following options:
e The Yt button opens a trend diagram
e The YX button opens a characteristic curve

e The Logic button opens a logic diagram

t=l Please choose: E@

Show diagram:

Cancel X

Description:
e Yt-diagram (trend) : Describes the most frequent application.

¢ Yx - characteristic curve The classic example is a tensile test on metal rods
with tensile force being calculated along the way. In combustion engines, torque
can be calculated from rpm.

¢ Logic diagram: Used, for example, in fault tracing in plant and machinery.
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3.3.2 Assigning specific names

Right click the name » Select Rename

r ™y

s ProfiSignal Go (== [ =]

File View Settings Window Help

HE2 2 0H (=]

Project management
El{ﬂ MesFiles

------ f{..) Formulary

ot [

Clase Online Analyse

Channel choice
Trend settings ...

Recorder settings ...

Rename
%

Delete Online Analyse
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3.3.3 Open/delete existing Online Analysis
Open/delete existing Online Analysis
=4 ProfiSignal Go E=N Ecl =
File View Settings Wigdow Help
MEM T[F | peg
EHEEZ = 0@ (=
The following dialogue is displayed:
General view Online Analyse @
|Autostalt | Mame Diagram type |
Orline Analyse_1 “t-diagram
Orline Analpse_2 “rt-diagram
n Oszcilloscope & [, “rt-diagram
Sine o “t-diagram
v Temperatures “'t-diagram
Test channels & “t-diagram
Triangle 't-diagram
Open ] [ R l [ Delete

The following options are available:

Select Online Analysis

Open selected Online Analysis

Delete selected Online Analysis

Online Analysiss that are check-marked are automatically loaded on restarting
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4 Trends, Yt-diagrams in Online Analysis

Learn how to operate, configure, assign channels and evaluate measurement data
using trend diagrams.

A trend can process large numbers of channels. Specific channels can be accessed
using a hide/show function.

Up to four measurement axes can be used. Channels can be assigned to the
individual axes. Axes can be extended and compressed and shifted against each

other.

A trend diagram is assigned to each Online Analysis.
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4.1 Trend diagram layout

Toolbar
Show/hide

Delphin

Technology

Graph area Channel table

= Ol & lese - Tempersiuren =100 x|
Y D ey EI
Kanauer | pobiarcen | usbionsn |
Furbe 5., Nams it Erky
l M~ AdlenTesy. 18,1 L
M B ¥ SchvankTeng. [T 3
W~ Roumeng, T L
ELE
Pl
————
e T T T
14 70 14000 14100
FaH-2000 q "
i : Ak M AF e a4 L B E
£ + +* X e Q- ; :
S~Ep ¥ =T LI B &5
Toolbar

The trend diagram is made up of three areas:

e Graph area
e Channel table

e Analysis tools

Channel colors are the same for the channel table and graph area.

ProfiSignal Go manual
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Click the toolbar icon to hide/show the toolbar.

t=l Online Analyse - Online Analyse
Online Anglyse  Settings  Window

= B& E E

The toolbar provides a wide range of evaluation functions.

i ® o NS EX
e - + > L B O 4 "E He .
j"r“" £ ¥ v a ¥ n Return R =]

Delphin

Techmology

The toolbar functions are described in detail in the Analyse mode for trend

diagrams section.
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4.2 Creating a new Online Analysis
File » New Online Analysis

k=1 ProfiSignal Go Fal-E ]

File Wiew Settings Window Help

Open Global Alerting = |

JB-3New Online Anabyse |
&

Open Online Analyse ...

& Open Mesfile
% Readout Device Storage
ﬁm Show DataBase in Trend

@ Recent measurement files *

Exit

Creating a new Online Analysis

t=1 ProfiSignal Go = [ S|

File View Settings wWindow Help

22 E =5 06R ([Ha)
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The following dialogue is displayed: Select Yt-diagram.

t=1 Please choose: El

—Show diagram:

+*
W Colar {7

Cancel X

This displays the following dialogue.

] Choose Channels - Online Analyse_ 3
Channel Walue State Name 2 | SizeMalue State
) Expert Key 100L - [P A Test channel sine 942 Ok
E}W Saftware channels ] :H:|
& A Test channel sine 9.92| 0k
E-F B Test channel rectangle -9.00) Ok

vannel triangle

<] D Test channel sawtaoth 0.24 Ok

4] | »
[ ak. ] [ Cancel ] ’ Help ]

You can now select the channels for your Online Analysis as previously described.
The Yt-diagram then opens automatically.
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4.2.1 Edit X-axis (time axis)
Multiple options are available.

In online mode

Right click the time axis. A numerical time period can then be set.
This applies to online mode and can be altered via the analyse mode (offline) (refer

to the Online / Offline section).

In record mode

While measurement data is being written to an *. hds file, you can switch between
relative and absolute times using the time axis button.

Time axis button

Recording on
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In offline mode
Refer to the Analyse mode for trend diagrams section

In offline mode, you can use the zoom, pan and drag buttons to adjust the time
(and value) axes.

These settings are saved when you exit the analyse (offline) mode using the pause
button.

Zoom Drag Pan

] «

Pause
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4.2.2 Add Y-axis

Up to four Y-axes can be used. The Y-axes can be positioned to the left and right
of the curves.

Move the cursor to the channel table and right click.
This opens the following dialogue
Select: P add Y-axis

|- e
channel filterl shiow all | hide: all |
Colar |U..|Name |Walue | Uit
B v 2 Test channel sine 10,00 Wl
W v E Test channel rectangle 9,00 Wl
B v C Test channel tiangle 0,00 Wl
[ v D Test channel zawtooth 0,00 Waolt
Sorting »
Columns K
channel filter
add ¥ axis I}
Y axis settings
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This adds an additional Y-axis.

t=] Online Analyse - Online Analyse_ 1 E@
Online Analyse  Settings  Window
E RS =] “rt-diagram it
vz i channel hlter| show all hide all |
Color .| Mame Wale Uit
S
: : : : M ¥ A Test channel sine -9.30 olt
B T el [ oo Ml v B Test channelrectangle  -3.00 Walt
M v C Test channel hiangle -1.68 Yalt
v D Test channel sawtooth 5,28 Waolt
+ Y2
L - b e breeeaes
2004 200 b .
1504 150 e b e breeeaes
f i f i
40,000 sec 41,000 sec 42,000 sec 43,000 sec
09.08.2010 13:51 r N

The added Y-axis with the default name Y2 is also displayed in the channel table.
This Y-axis has not yet been assigned to a channel.
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From the channel table, select the channel that you wish to assign to the Y-axis.

Right clicking opens the following dialogue. This enables the selected channel to be
assigned to the Y2 axis.

L
channel filterl show all hide all I
Colar | W.. | Marme |Yalue | Urit
=

M (v A Test channel sine

3,63 Yalt

B v E Test channel rectangle

3.00 Yalt

[ v DTes
[+ 2

Y2

linear
steps
Channel settings ...

move to y-axis J

add new y-axis

A dialogue is displayed that lists the current Y-axes to which channels can be
assigned.

In the example the YZ2-axis is assigned to the Test channel triangle channel.

=% =R (=

[l

channel filterl show all hide: all |

. | Name | Value

| Unit

M v 2 Test channel sine 8,76

Wolt

- [v B Test channel rectangle  9.00

“Walk

[ v D Test charmel sawtooth 0,96

M v CTest channel tiangle 2.24

Yolt

olt
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4.2.4 Y-axes configuration
Click the axis you wish to configure. Select y-axis settings:

2 Y1

300 300

P —

y-axis settings I},
Show timerange

2507 Export »

MouseCursor/Marker Settings 2

After selecting y-axis settings, the following dialogue is displayed.

[ Edit V-Scale =

-

Settings

Scale caption: Y2

Short ticks: Ol Min Ticks 3 2
Scale colar; . Width 50 il
Poszition: Left ¥

R ange

Fange low: 1396 il Range high: 2523 il

Relative vz

The axis can now be configured as required.
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4.3 Using trend diagrams in Online Analysis

Trend diagram layout

Toolbar Graph area
Show/hide
152 D & @ “t-diagram
N
B
' L J
10.0
504
0.0+
504
-10.0 4
DS,4DID sec DS,E-DID sec DS,&DID sec DS,TDID sec
09.08.2010 16:11
HE ¥ 4+ * »d @ s 0
+ > -H PO
.r"r""— 34 * v A W 1] Retum
Toolbar

The trend diagram is made up of three areas:

e Graph area
e Channel table

e Toolbar

Click the toolbar icon to hide/show the toolbar.

Delphin

Technology

Channel table

chanrel filter | shaw all | hide all

Calar | ¥.. | Mame W alue
(M v Roomtempersture 9,92
M [~ Outer Temperature 056
M v Temperature 2 B.7R

4 3

A H

] =]

3

Info:

The channel table is described in the Using the channel table section.
The toolbar functions are described in the Measurement data analysis section.
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4.3.1 Global operating buttons

This toolbar is located at the top left of the diagram.

Show/hide toolbar

Sl=1EY

Enlarge graph area Enlarge channel table

4.3.2 Assigning channels to a trend

Channels can be added / deleted at any time. This takes place via a menu in
Online Analysis.

Online Analysis » Settings®» Channel choice

t=1 Online Analyse - Online Analyse_1
Online Analyse | Settings | Window

11_-_,;2 D & E Channel choice ...
|
Y 1 Trend ...
: Recorder ... —
E ¥ Auto save
?:-III.III—"E"" Autostat 0000 |

This opens a Choose Channels dialogue. You can now amend the channels
selected for Online Analysis.
The channels displayed on the right are those assigned to Online Analysis.
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4.3.3 Using the channel table

Hide / show channels and filtering

These functions enable you to focus on those channels that you are currently
interested in. All other channels are then hidden.

Show / hide specific channels

Channels are displayed when active (check-boxed). Left clicking the field hides /
shows the channel.

Show / hide all channels

The show all and hide all buttons enable all channels to be displayed or hidden.

Removing hidden channels from the channel table

The channel filter button or channel filter context menu (right clicking the channel
table) enables non-active channels to be removed from the channel table.

channel filter | ghow all hide all
Color (W, | Mame Walue It
B v A Test channel sine 3.09 Yalt
B v C Test channel rectangle 9,00 Waolt
v [ Test channel sawtooth 2,40 Walt
B v C Test channel tiangle 5,60 Waolt

4.3.3.1 Show / hide specific channels

You can show / hide channels in the graph area by checking / unchecking the
channel in the channel table. Deactivating (unchecking) a channel hides it.

channegiter | ghow all hide all
! Colaor | W.. | Name Walue
. El_ & Test channel zine

|| Test channel rectangle -9.00
v [ Test channel gawtooth -1,63
|| C Test channel tiangle -3.92
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Left click the channel in the channel table to enable the channel color to be

amended.

charinel fiIterI show all | hide: all |

| alue

B Test channel rectangle

[0 v D Test charnel sawtooth 0,48

M v C Test charnel tiangle 112

This opens the color palette. A new color can now be assigned to the channel.

&

Color
Basic colors:
mEaE Sl B B
FENENEENN
FEEEEEN
FEEEEEN
EEEEEEN
8 0 0 B0 Ol
Custom colors:
EEEEEEENR
[T A EEEER
[ Define Custom Colors > ]
| oKk || Cancel |
42
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4.3.3.3 Highlighting channels and channel groups

Highlighting a channel

Select a channel from the channel table to activate it. The curve in the graph area
is then highlighted and brought into the foreground.

A further click cancels the highlight.

Color |V | Mame | alue | Unit
=1
B v & Test channel sine .37 Walt
M v E Testchannel rectangle 9,00 Walt
[ v D Test channel sawtooth 4,32 Waolt
=2
_-EI C Test channel tiangle M

Highlighting channel groups

Selecting a Y-axis from the channel table highlights the Y-axis and its
accompanying channels in the graph area. A further click cancels the highlight.

Color |V, |Mame | alue | Ui
=
B (v A Test channel sine 3,09 Walt
M v E Testchannel rectangle 9,00 Walt
[ |+ D Test channel zawtooth 2,40 Walt
=2
B v C Test channel tiangle A.60 Walt
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4.3.3.4 Amending line thickness of the graph

The line width can be amended by right clicking Channel / Channel settings... .

Colar |"»-".. | M arne |"-"a|ue |L|r‘|it
A Test o i
v EBTestc v linear
[ DTestc steps
M v CTeste Channel settings ... Ilp

F

rowve to y-axis »

This opens the "Channel Settings" dialogue.

Channel Settings
—Setting
M arme:; & Test channel zine
[nit: Walk

Comment:  Test channel with a zsignal in form of "Sine" and a channel az
amplitude

Channel settings | Reference |

~General
Colr !
Linestyle linear |
Lineswidth | 13
Symbol | n |
~Filker
[ Mirimurm active | 102
] Masirnum active | 103
<k Previous | = Nest | W 0K X ot | ? Help

Amend the line width value. The default value is "1".
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5 Recording measurement data in Online Analysis

ProfiSignal Go enables continuous and batch data recording.

Measurement data files can be set up with start/stop settings at the same time as
data is being permanently recorded as a background service. Data records can also
be set up with manual start/stop settings.

Continuous data recording

Important for the monitoring of plant and machinery, for continuous production
processes, for the acquisition of quantities, endurance testing etc.

==z ¥T-Oagramm

w2 oovt
240
E¥1
ﬂ% M ¥ mrentemn, 17,7 o
22.0 4, ol s = .mfm'\ M ¥ AufenTemp. 11,7 o
W “"-"\ M [ SchrarkTemp, 20,9 °C
T

)
wa\ /Aﬂ ’
000 - \J
e
Nt N,
“u A
p—

0800 16:00 00:00 0500
02052010 03-05-2010 5

Batch data recording (recorder files)

Important for experimental trials, fault data acquisition, fault detection, the
monitoring of plant and machinery, production processes etc.

nnnnnnnnnnnnnnnnnnnnn

Info:

A combination of recording methods can be used. Batch recording can be
performed at the same time as continuous data is being recorded.
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No data recording

With no database and no current batch files, there is then no recording of
measurement data.
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5.1 Continuous data recording

In continuous data recording, data is recorded to the DataService on a channel
basis. Measurement databases can be set up. Measurement data can be portrayed
in the required trend diagram.

The data can be accessed by any application connected to the DataService.
Measurement data is recorded independently from applications. Data is therefore
acquired and recorded even when there are no applications running.

This recording method means that movement can be made along trend diagram
time axes from the current measurement value back to anywhere in the past. Data
is displayed immediately, without any delay.

Use

Important areas of application are in the monitoring of plant and machinery, in
continuous production processes, in mass data acquisition, endurance testing etc.

Database set up in DataService

For continuous data recording, database set up is required within the DataService.
Measurement data within the databases is then available to any Online Analysis.

In continuous data recording, data is recorded to the databases so that historical
data is available to Online Analysis.

3

Info:

Data is recorded to the database when the DataService program is running.
When the DataService is not running there will be interruptions in the continuous
data recording.

Benefits:

A special feature of the DataService is that large masses of data can be processed
at a high level of data resolution. The data can then be displayed at high-speed
onto the screen.

No online/ offline restrictions for trend portrayal

Delphin's DataService removes the restrictions on online/offline processing. This is
a first for the DataService and distinguishes it from other products. You can move
along the trend time axis from the current time back to any time in the past. A
zoom function provides high-resolution portrayal of historical data.
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The following example describes the setting up of a database and the assigning of

channels to the database:
e Run the DataService Configurator.

e Click the Database tab.

e Right click DataService... from the displayed tree.

e Click Add measurement database.

f_-‘_.' DataService Configurator

Connect  View Opticns  Help

=N EoR =)

| Eonnec_tiu:unsl Channels| Database |.-’-‘«Ierting | Schedulerl Llzer management|

M ame
E' DataService [0 1760

g?

Configuration | Events |

This opens the Measurement database settings dialogue.

Measurement database settings

General | Duration ¢ Size I Trend optimization I Backup I Filter |

=3

Mame

Temperatures Enable storage

Comment

—Storageplace

Eath

%data

Filename [without extenzion)

TemperatureChannelz

Default data subdirectorny: %data

Lok |

| Cancel | | Heb

o Input a Name, e.g. Temperatures.

e Enter a Filename, e.g. TemperatureChannels.

e Confirm with “OK".
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A "Temperatures" database now appears on the right of the Configurator dialogue.

Connect  View Options  Help

lf_-? DataService Configurator E'

| Ennnecﬁiunsl Ehannels| Database |.-'1‘-.Ierting | Scheduler | User managementl

M ame Ao | SizeMalie

Online

Starage achive

Configuration | Events

-

5.1.2 Assigning channels to a database

From the left menu bar » Select channels

To assign channels to the Temperatures database, channels are moved using
drag&drop from the left to the icon for the Temperatures database on the right.

Copies of the channels are then installed within the database.

“2 DataService Configurator E
Connect  View Options Help
Connections Ehannelsl [atabase I Alerting | Scheduler | User management ‘ Connections I Channelsl QatabaselAlerling I Schgdulerl User managemanll
Channel 2| Walue State - Mame 2| SizefValue State -
Expert Key 1000 = g DataService |D 1760 Online
:|>— Roomtemperature -| Inactive Tl E‘ﬂ Temperatures 403 kB Storage active
- Ampltude (Sinet) 004 miv | Dk - Outer temperature 015°C Ok
:|>— Roomtemperature - Inactive
:|>— Temperature 2 043°c Ok
:|>— Temperature 3 074°C Ok
<] | E’E
Configuration | Events
You should now see the display below-on your computer screen.
| Connections I Ehannels| Qatabase| Alerting I Sn:hgdulerl U zer management|
M arme A | Sizealue State A
= [J) DataService 1D 1760 Orline
= ﬁ Temperatures 403 kB Storage active
: - :|>— Outer temperature 015°C Ok
- :|>— R oormternperature = [nactive
- :|>— Temperature 2 093°C Ok
L :|>— Temperature 3 0.74°C Ok
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5.2 Batch data recording (recorder files)

Batch processes are distinguished by having a finite duration with start /stop
conditions. Manual start / stops are also a feature.

The recorder is the ProfiSignal Go software component responsible for storage. The
data is stored to a recorder file.

Important application areas for batch recording are experimental trials, fault data
acquisition, fault detection, the monitoring of plant and machinery, production
processes etc.

Recorder files are located in a folder with the Online Analysis nhame with which they
were created.

=l=IEN

100

45,500 sec. 46,000 sec 45,500 sec. 47,000 sec 47,500 sec. 48,000 sec.
052010

Info:

Batch recording can be performed at the same time as continuous data is being
recorded to databases.
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5.3 Configuring recorder files

A range of settings can be made in order to achieve optimal results.

Recorder files are located in a folder with the Online Analysis name with which they
were created.

Access:
From the main menu of the Online Analysis

Select W Recorder from the Settings tab.

b= Analyse view
Online Analyse | Settings | Window

]5-2 D & E Channel choice ...
¥ 1 Trend ... |
T Recarder ...
1004----+ b
E v Auto save
E Auto start

This opens the Settings - Recorder.AnalyseRecorder dialogue.

ProfiSignal Go manual 51

© 2003-2011 Delphin Technology AG



ProfiSignal Go Delphin

Techmology

Settings - Recorder.AnalyseRecorder

Filzname | Trigger I S aving u:upti-:uns|

FileM ame

(71 Filename [placeholders)

avenanite data

(@ append data

@ Mame + enumeration
() Mame + date + time

(71 Mame + date + enumeration

Filenarme:

AnalvzeRecordermesfile iz

Preview flename: AnalyzeR ecordermeszfile_007

Fath

CAProfiSignalhD atahOnline Analyee 1 Search

IJge Default Directan C:AProfiSignahD atahOnling Analpze_1

| ok | [ cancel | | Hep

The Filename tab enables individual names to be automatically assigned to files.
This is especially important for experiment series.
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The Trigger tab enables trigger conditions to be set for the automatic generation

of trigger files.

Triggers can be time related or associated with a specific channel.

Settings - Recorder.AnalyseRecorder

Trigger | 5aving options

[7] Deactive Triggers

AutoStart Trigger
Start
(7 time related
@ triggered

(7 manually

(") Leweltrigger High:
(71 Lewveltrigger Low:

@ Rising edge tigger:

Allows manual Start and Stop

Stop

() time related
@) triggered

(7 marwaally

@ Rizing edge tigger:

(7 Trailing edge trigger:

Triggerchannel:

ProfiSignal Go manual

() Trailing edge trigger; - o channel - -
Triggerchaninel:
- no channel -
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5.4 Loading recorder files

A batch process can be loaded offline by loading one of its recorder files into a
new trend, which is then automatically generated. All the functions from Online
Analysis are then available for evaluating the batch process.

Load the "*.hds" recorder file type.

Clicking this button opens the folder in which the recorder files for the Online
Analysis are located. You can then select the required data from the list.
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5.5 Recorder data information
Recorder data information is displayed continuously in the recorder bar at the
bottom of the screen.
It contains information on the recording and enables a recording to be:
e manually started

e interrupted (paused)

e ended.
3 Arslyseview =le e
Online Analyse  Settings  Window
1232 D & @ ‘t-diagram Iﬂ
A channel filterl show all | hide all |
Caolor |V.. | Mame |Value | Ut
1009 M v & Test channel sing 309 Wi
B [ B Testchannel rectangle 9,00 Wi
m D Test charnel sawtooth
- [w C Test channel triangle B.E0 e
5.0+
0.0
-5.0+
R e e P
f f f f
38,000 sec 35,000 sec 40,000 sec 41,000 sec
09.08.2010 15:14
4 3
| KN 1
F!:c m |l AnalyzeRecorder |ﬂ|
File name K status time |data
\ 0 Byte
N
Local time (PC) \

N

The recorder bar contains information on recordings and enables the manual start /
stopping of a recording.
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5.6 Recording manual start / stop

Start recording Stop recording Pause

Rec

File name

Analyzef ecordermesfile_002

Input recorder file names.

Hﬁmaf}fse'.riew
Online Analyse Window

]32 D & E Channel choice ...
v 1 Trend ...
— Recorder ...
10.04----+ b
v Auto save
Auto start

Recorder file names can be assigned using the recorder settings. The name can be
a specific name.

3

Info:

Subsequent recordings overwrite the original file.

Multiple, automatically generated, sequential file names are available for data
recording which then avoids the overwriting of data. These files are saved to a
directory with the name of the Online Analysis.
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6 Measurement data analysis

Operating and analysis modes are available in ProfiSignal.

The operating mode runs online and provides access to the most recent data. The
analysis mode runs offline with online/offline switching available at the click of the
mouse.

ProfiSignal has an extensive range of evaluation tools. The functions are operated
via toolbar buttons.

In this section, functions are described for the toolbar buttons. Operation and
observation of an Online Analysis takes place online. Measurement data is analysed
and evaluated offline (analysis mode).

1232 D & @ ‘rt-diagram Iﬂ
¥ channel filter| show all | hide: all

150 R FEEEEEEEEEE e REREEEEEEEEEEE Color | .. | Mame alug
: : : : : : M |v Roomtemperature  -7.23
M v Outer Temperature 3,36

— i

100-fi e

R S

T T U U T T
08,720 sec 08,740 sec 08,780 sec 08,780 sec 08,800 sec 08,820 sec
09.03.2010 18:11

He @t 4 W+ ] e 10 £
‘.r‘: -~ £ = * R .H : : ; m Fietumn |'R'I =]
Toolbar functions for analysis mode Button for switching

between online/ offline
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6.1 Online / offline

This is a central function of analysis and evaluation under ProfiSignal.
Online (operating and observing mode)

The online status is characterized by the continuous input of new measurement
data into the graphical portrayal. You are now in the observation mode (watch
mode) and are able to observe what is currently taking place.

Offline (analysis mode)

The offline status is characterized by the graphical portrayal receiving no new
measurement data. An extensive range of evaluation tools are available via
buttons on the toolbar.

EAR S E A ‘t-diagram ml]
A channel filter| show all hide all |
. j j j j H H Color |%.. | Mame Walue
150 oo oo oo S i [ ey - <

[ | Outer Temperature
M [ Temperatue 2

-10.0 4

ur,zulu seC umu‘u s&C W,eulu sec n?,sulu seC us,uulu seC us,zu‘u sEC
09.02.2010 16:11 4 »
T ‘_4_’_” Y B s 0 A i
— £ ¥ s I = 1 1] Return |R1 =]
Toolbar
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6.1.1 Switching between online and offline

The pause key enables you to switch between online and offline.
Clicking on the pause key puts you in analysis mode (offline).

Clicking off the pause key puts you in watch mode (online).

NQ s v

[ | Fieturn
Pause key
Online/offline Return key
Return to online
mode

The return key is an alternative key to move from offline to online status.

Switching from offline to online using the pause or return keys has differing
effects:

Function when switching using the pause key

The offline settings for the time and value axes remain. When the time period in
offline is set to the past, the online time period will be moved to the present. In
this way new data is included without any interruption.

Function when switching using the return key

The offline settings for the time and Y-axes are reset to the original online
settings. The observation mode is therefore reset to its previous values.
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6.2 Overview of the most common functions

Zoom, Pan and Drag are the most commonly used functions.

Zoom Pan Drag

] Q

6.2.1 Zoom using the mouse

Zoom on/off

] @ oo

Clicking the zoom key (arrowed), or double clicking on the graphic will display
cross-hairs on the graph area. You can now mark an area using the left mouse
key. Releasing the mouse key will enlarge this area to the full graphic size.

EEK ED ¥T-Diagramm
V1

Kanaffilter | Einblenden
Farbe | 5., | Hame
IS SO SN N | M [ A Testkanal Sin

ADD - mmmmm oo

T 7 7 7
08,200 sec: 08,400 sec 08,600 sec: 08,800 sec 09,000 =

2B DAIEEWST: o7 7 ‘ |
HE P X s G0 O 0 b =
o - “"'t"'” SR E o B & e
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6.2.2 Uninterrupted panning using the mouse

|

mow ¢
L1 *

Use the pan key (fist) to smoothly pan along the time and Y-axes.

6.2.3 Uninterrupted expansion / compression of curves (dragging)

RIS
Th

Expand or compress (drag) the time and Y-axes using this symbol.

4

-~ Hiﬂ — -

Y

6.2.4 Switching between pan and drag

By double clicking one of the buttons enables switching between pan and drag
modes.

This can be extremely useful. With more experience, the user will become aware of
its practicality. Double clicking makes working procedures easier.

6.2.5 Panning the axes in steps

-« > M

[,

W

4
¥

These symbols enable left/right and up/down step panning along the time and Y-
axes.

The left and right symbols bring you to the beginning or end of the measurement
file. The grey left symbol is available only for offline batch processes.
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6.2.6 Dragging the axes in steps

Dragging the time axis

9 M 1) =« '
v A
v A w 4

Dragging the Y-axis

These symbols enable step dragging of the time axis (upper row) and Y-axis (lower
row).

Portray entire recorder file

4
(2]
L]

The symbol on the upper right is available only for offline batch processes. It
enables portrayal of the entire recorder file. The batch process can then be
visualized as a whole.
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6.2.7 Autoscaling

Autoscaling

The Autoscaling symbol (arrowed) sets minimum / maximum values for curves,
channels and Y-axes. The minimum / maximum values for the curves are visually

portrayed.
EEE El B “ft-diagram )
Y2 Y1 channel hIterI show all I hide: all I
Color |V Mame | Value
10,0 =

M ¥ Foomtemperatuie 9,92

M [ Outer Temperature 0,56
By

M v Temperatue 2 0.24

404

5.0

2.0+

0.0
0.04

-2.0+4
-5.0+

-4.0- T T T
06,800 sec 07,000 sec 07,200 sec
09.08.2010 18:11 4 | | ﬂ
e 4 O FOde oo Llm B o
H- + + -H a~ v &
— E £ ¥ = X = m Retun @ =
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6.2.8 Show/hide gridlines

Show/hide gridlines

B
o~

!l ||
pec| M [ 01

6.2.9 Magnify function

The magnifying glass function in the right illustration is available only for opened
measurement files (type "*.hds"). Activating the magnify function splits the trend
into two sections. The lower section can be operated as normal. The upper
sections displays the entire measurement file. The blue lines show the area
displayed in the lower section.

L¥ D & Trend
Y1
a0+
20 —J"l\j’ql“ﬂr\"'l"\"“— TT“ ‘“‘|‘JT""—1’T"‘—"|’_'“LT"
104
0 _M—WAM
-10- T T T
19-Jan-2006 22-) an-2006 28-Jan-2006
Y1
20,01
10,0+
0.0
T T T T
0&:00 1200 18:00 0000
23Jan-2008 24-)an-2006
= ¥ SR E
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6.2.10 Relative / absolute settings for the Y-axes

These can be switched between values and percentages.

Switching between absolute values/ percentage values

.
A

-
Hecl || | II|

6.2.11 Relative / absolute settings for the X-axes

These can be switched between values and percentages.

Switching between absolute values/ percentage values

[T
=t

Fiec

3

Info:

Relative time axes are available in the recorder mode. This is the case when data
recorder is running online or a recorder file (*.hds file) has been loaded into a
trend.
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6.2.12 Measurement curve portrayal

Stepped or smooth joining of measurement points

i
=.,.l"'r-"“"E|FV

L 4
Rec

This button enables the joining of measurement points either as a smooth curve or
a stepped curve. Smooth joining is the default setting. Stepped joining is
necessary when the individual points require measuring out.

Mark measuring points

|
Pl k¢

»
pec | H | NN

This button enables measuring points along the measurement curve to be marked

with a small cross. The measurement points can be portrayed as joined or non-
joined.

6.2.13 Undo function

k)

R eturn

These buttons are used to undo previous actions.
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6.2.14 Return to online status

ﬁiﬂ KT
1] Feturn

"X

Returning from offline mode to online mode

Use the Return key to revert to the online mode.

The Return key is an alternative key to the Pause key to switch from offline to
online modes. Switching from offline to online using the Pause or Return keys has
different effects.

(Refer to Switching between online and offline)
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6.3 Oscilloscope mode

The oscilloscope mode enables a static portrayal of high-speed signals.

Oscilloscope on/off

|H e
il = ki

Fiec

You can set the time range for the static portrayal. All measurements occurring
during this period are then portrayed.

Synchronizing the time period with the measurement signal frequency will create a
static portrayal. This means that the time period must correspond to the signal
frequency; or be a multiple of it.

S

Example:

If the signal frequency is 10 Hz and you set a time period of 1 second, then the
static portrayal will have 10 oscillations.

Time settings

Diagram menu

bl Analyse view
Online Analyse | Settings | Window

1‘7_{2 D & E Channel choice ...

T

Trend ...

Recorder ...

Auto save
Auto start
A [ A

Select from the Analyse view W Settings » Trend
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The following dialogue is displayed, in which you can adjust the time period.

Settings - Yt-Diagram.Yt-diagram

| Settings Trend | Dsciloscope mode | Print Layout|

1

—Ozzillozcope mode
(70 Timerange 5000 ﬁl Maec

@ Block
Triggerchannel

- nio channel -

Customizing
Automatic ozcilmodus

[ Ok ] ’ Cancel ]

|

Help

Ensure that the Customizing and Automatic oscillmodus fields are check-boxed.
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Markers
Markers are an important tool to evaluate and document properties along the
measurement curve.

With Markers, you can set time markers at any point required. Text can then be
assigned to the time markers. Markers can be stored so that they appear with a
subsequent evaluation of the measurement files.

Markers may also be exported to other programs.

Marker overview

Add marker and text Show/hide marker Delete marker

v o

£ |
N

The functions for the separate buttons are described in the following sections.

6.4.2 Assigning text to a marker

Assigning text to a marker

£ &
&~

e Left clicking the symbol will display a cross-hair.

e Position the vertical cross-hair at the time value where the marker is to be
displayed.

e Confirm by left clicking. The following dialogue appears to enter the marker
settings.
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bod Marker properties

@ &l channels
(7 Yizible channels

Selected channel

Lok

Local time (PC)

M arme:
Test:
e
Al
P b

Timestamp: 09.08.2010 15:57-01,291

Cancel

Set markers

e Online Analyse - Online Analyse EI@
Online Analyse  Settings  Window
EEE El A Tt-diagram w1l
A charnel f\|t8l| show all | hide all I
" MaxValue ' ' ' Color |¥. |Name | Value | Unit
10.0 —t 1B5E55,009- < - - -4 o mm oo M |¥ Roomtemperature 0,63 T
HUUI‘HEJ‘BIG[U[E‘"‘],DD o H H M v Outer Temperature  -6,72 C
| M v Temperatue 2 312 C
5.0+
0.0+
T L r e R LT TR PR FE P TR e SEPREP P RETEE PR PRPFERPEPRERRRERR &
B
54,90‘0 SEC SS‘UD‘D sEC 551 DID SEC 5520‘0 s&C 55,30‘0 S&C
09.08.2010 15:58 4 | | ﬂ
HE P X “_‘_4*_” I R N R S T v T S By &
’—’*"’Ety * :Z: Iﬁ Return k@‘l ﬁ
Local time (PC)
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6.4.3 Show / hide marker with text field

Show / hide marker with text field

i
N

6.4.4 Deleting marker with text

Deleting marker with text

i
N

Left clicking the symbol displays a dialogue that enables markers to be deleted.
With multiple markers, select the marker to be deleted.

Marker
M ame Timeztamp Dezcription Stored Comment

|| 09.02. 2010 15:58:55 009 Store |
Copy |
Expart |
ﬂ Delete |

Filter: &l markers -
Local time (PC)
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6.4.5 Saving markers and copying to the clipboard

Save marker Copy marker to the clipboard

l

i
N

This opens the following dialogue

Marker
Mame Timestamp Description Stored Comment
» 09.08.2010 15:58:55,009 Store |
Copy |
E:-:port |
ﬂ Delete |
Filter:  All markers v
Local time (PC)
Copying

The Copy button copies the marker data to the Windows clipboard.

Deleting
Select the required marker.
The Delete button deletes the selected marker.
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6.5 Mouse cursor

The mouse cursor is an important tool to set, evaluate and document time periods
along measurement curves.

The mouse cursor enables you to set time periods at any point. You can then

evaluate this period, store the data to an *.hds file or export it into other
programs (for example Word).

Setting the mouse cursor

£ &
R

g

Clicking the Mouse cursor displays two vertical cursor lines on the graph area.
Position the mouse pointer on the cursor line you wish to move. Move the cursor
line to the desired position by left clicking.

W

Cursor 1 E B Cursor 2 E
08:35:45, 254 : 08:35:49,253 ( 0,398 sec )

: Sinus 10,00 Yalt : 10,00 volt £ 0,00 )
10.0 4 : . : .

a0---

on—--

-5.04

-10.0

T T T T
43,000 sec 43,500 sec 49,000 sec 49 500 zec
29042010 08:35
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6.5.1 Evaluation

Time difference
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Technology

Move the cursor lines with the mouse and the time difference will be displayed at

the cursor lines.

Channel values

Selecting a single channel from the channel table displays its values at both cursor
lines. You are then able to measure this specific channel. If no channels are
selected, every channel is then displayed that is visible within the graph area.

Statistics

Right clicking between the cursor lines enables statistics to be displayed.

I 1
v Move MouseCursor

[

Show timerange

Statistics

. Export LI
MouseCursor/Marker Settings L
Debug »
: 1 I
=1 Online Analyse 6 - Online Analyse 6 - Vt-diagram - Statistics EI@
Color | Mame Unit Cursor 1 “alu... | Cursor 2 Walu... | Difference tinimurn time [minimunn) tdaximum time [maximunm)
l Roomtemperature °C 876 Ok 303 Ok BE7 3.09 03.08.2010 8.7e 09.08.2010 £
16:11:06.200 16:11:06,080
l Outer Temperature T 224 Ok 560 Ok 336 224 n3.08.20m0 560 n3.032mo
16:11:06.030 16:11:06,200
l Temperature 2 C 0.96 Ok 240 Ok 144 0.96 03.08.2010 240 03.08.2010
16:11:06.080 16:11:06,200
4 »
03.08.2010 03.08.2010 B | B E | e
Starthime c11.08,067 Endtime 16 11.06,205 ERh Copy By Bt | [ M e
Local time (PC)

Copying to the clipboard

The Copy button enables the area to be copied to the clipboard and inserted into

other programs (e.g. Word).

ProfiSignal Go manual 75

© 2003-2011 Delphin Technology AG



PmﬁS@Go Delphin

Techmology
6.5.2 Saving to a measurement file (*.hds file)

This area can be exported to a measurement data file.
This takes place by doing the following:
Right click between the cursor lines » Export W data export

il

i ¥ Move MouseCursor

Statistics

e e e e e, ——

:|: Show timerange

Export 3 ASCH export (all channel] ...
MouseCursor/Marker Settings b ASCI export (visible only) ...
. ASCH export settings
Debug 2
= data export (all channel] ...
I data export (visible only) ... I:}‘

Export trend and legend to EMF

E Export trend to EMF

Export trend to clipboard

' ] '
This opens the following dialogue. Input a name and then save the measurement
file.
e Data export save as @
Savein: || Online Anatyse_6 - @ ? sl g

10-04-29 001.hds

& 20
i 2010-04-29_002.hds

SELME

File name: | - Save

Save as type: lF‘mﬁSignaI MesFile {~ hds) '] Cancel

Help
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6.5.3 Exporting to other programs

e

i v Move MouseCursor

Statistics

e e e e mmmmmeF e — -

:|: Show timerange

Export 3 ASCH export (all channel) ...
MouseCursor/Marker Settings J ASCI export (visible only) ...
. ASCH export settings
Debug 2
. data export (all channel) ...
I—' data export [visible only] ... I:}

Export trend and legend to EMF

: Export trend to EMF

Export trend to clipboard

Exporting to CSV file
Right click between the cursor lines » Export W ASCII-Export
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6.6 Saving / loading configurations

This function is useful for recurring and similar configurations.
A trend configuration can be saved under a specific name.

The saved configuration can be loaded into a trend.
Only the channels then need to be assigned to the trend.

Save configuration under a specific name

iy
4

(i
®

Load a saved configuration

Configurations can be given specific names.
Configuration files are given a *.tcg file extension and saved to Config folder.
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6.7 Loading "*.hds" measurement data files

Measurement recordings are referred to as recorder files and are described in the
following sections.

A batch process can be loaded offline into a trend by loading one of the saved files

from the batch process.
All Online Analysis functions are then available.

Load a recording from an "*.hds" file

Clicking this button opens the folder in which the recorder files for the Online

Analysis are located.
Now you can make a selection from the saved files.
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6.8 Printing out trends

Print specific trends

= B
& By
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7 Appendix: Creating test channels

Function

Test channels are channels that require no hardware. When hardware is
unavailable, test channels can be used instead of hardware channels. These
enable functions such as sinus, square and sawtooth to be assigned to specific
channels. Test channels can be used to discover and test out the full capabilities

of ProfiSignal.
Test channels are set up and configured within the DataService.

Setting up a new group of software channels

DataService » Connections

In the DataService, select the Connections tab.
Right click on DataService from the displayed tree. This opens the following
dialogue.

“ DataService Configurator EI

Connect  View Options Help

CUnneC!iUNS| LChannels | Database I Alerting I Scheduler | User management|

Mame % | Host/IP

Connect Diivertype
nooo Cc

Add driver (connection) 3 TopMessage device

ProfiMessage device

Expert Key device (LAN)

Service mainsettings

Software channels
OPC Client (Licence needed) L}

DataService Client

More connection

Configuration | Events . .
’ Load connection settings

Select W Add driver (connection) » Software channels

A new Software channels category will then appear in the tree display.

“2 DataService Configurator E'

Connect View Options  Help

Connections| Channels| Databaze I Alerting I Scheduler | Uszer management

Charnnel A alue State Channeltype
) Expert Keyp 100L Expert Key 100L
. W Software channels Software channels

Configuration | Events
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Select W Channels, right click Software channels » Test channel » Create channel /

test channel

“2! DataService Configurator

Connect  View Options Help

=N =508

Connections| Channels| Databaze I Alerting I Scheduler | Uzer management

Channel

A Walue State

Channeltype

) Expert Key 100L

Software channels

Create channel

Configuration | Events

Ewpert Key 100L

Yariable channel

Testkanal

This opens a dialogue in which you can create and configure a test channel.

Active

Channelname  Sine-Signal

Linit

Description

Channel settings ‘Testkanal' (Sine-Signal @ Software channels)

Test channel with a zsignal in form of "Sine"* and a channel az amplitude

(=]

Main SEttinQS| Advanced settings I Noise|

7

i aveform [ Sine

— Frequency @ fived value  (0) variable value

P

Fized value 0.1 Hz 0
Samplerate 50 Hz ., \./\
— Amplitude () fived value @) variable value

Channel Amplitude [Sine1)

M ﬂ 0

— Phase

@ fived value () variable value

Fixed value 90 Degres

— Dffset @ fived value () variable value

Fized value 2

+ Previous |

P Mest | ' oK I

x Cancel | ? Help
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7.1 Configuring a test channel

Channel name and unit

Assigning a name and unit to the test channel. For example, Sine-Signal and a Sine
unit.

Channel settings 'Testkanal' (Sine-Signal @ Software channels)

Active

[ &3

Channelname  Sine-Signal

Lnit

Description Test channel with a signal in form of "Sine" and a channel az amplitude

e SEltiﬁgS| Advanced settings I Noisel

Waveform [Sine VI

Frequency @ fired value () variable value

Fived value 0.1 Hz ] [\
Samplerate B0 Hz \-/

Amplitude () fived value (@ variable value

Channel Amplitude (Sinel] - ,CD 0

P

Phaze @ fived value () vaniable value .
Fised walue 30 Degree 0
Offzet @ fired value () variable value

Fived value 2

4 Previous | & ‘ " 0K | X Cancel | ‘? Help ‘
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Frequency

Select Fixed value. A practicable value is between 0.1 and 1 Hz.

Amplitude

Select Fixed value. A practicable value is between 0.1 and 10.

Phase

Select Fixed value. A practicable value is between 0 and 180°.

Offset

Select Fixed value. Select an offset that shifts your curve away from the middle
and towards plus or minus.

Selecting variable value instead of fixed value

You can then select here any required channel - even another software channel -
whereby this channel will override the software channel.
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8 Appendix: ProfiSignal in networks

If you use TopMessage or Expert hardware, you can connect the hardware and
software to existing data networks via a LAN interface.

If you use the Expert hardware you can connect the devices to a PC via a USB
and perform data evaluation on multiple PCs.

Minimum configuration

A complete system requires at the least the following:
e one device

e one DataService program

e one ProfiSignal application

ProfiSignal
Application

DataSernvice

Info:

The DataService is the link between the measurement hardware and the
connected ProfiSignal applications.

The task of the DataService is to configure hardware and process measurement
data.

Measurement and control data travel from the hardware to the DataService
where it is passed on to one or more applications.

Distributed applications

The most frequent set ups use one or two hardware devices with one or two
ProfiSignal applications.

However, there are no limits. You can use multiple and differing hardware types
with applications from ProfiSignal Go, Basic and Klicks in distributed systems.

The DataService and the ProfiSignal applications can be distributed over multiple
PCs.
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ProfiSignal
Application A

ProfiSignal
Application B

DataService

ProfiSignal
Application C

DataService as a data server

4@ DataService as
el data server
It WE
. FrofiSignal
— Application A
iF L)
- FrofiSional
Lo Application B
- FrofiSignal
— Application B

It is to be emphasized that you are able to use existing company networks for
hardware/ software communication.
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8.1 Creating network connections

The DataService is the link between the measurement hardware and the
connected ProfiSignal applications.

Between hardware and DataService

By assigning hardware devices to the DataService.

(X%
|

Dataservice

Open the DataService Configurator.

“= DataService Configurator EI@
Connect | View Options Help

Configure local DataService o I Llser management|
Disconnect from DataService | Haoszt /P | Connect State
v Automatic connect DataService PC37 N{= Orline
Configure remote DataService [
Add driver (connection) * TopMessage device
ProfiMessage device L\\)

Start local DataService

Stop local DataService Expert Key device (LAN)

Software channels

OPC Client (Licence required) E
Ewventz

DataService Client
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Select » Connect » Add driver (connection)

¢ A dialogue appears showing all the hardware devices on the network that can be
included in this DataService.

e Double click the device you wish to add.

e The device's channels are now available in the DataService and will be processed

by the DataService.

Between the DataService and applications

These are linked by assigning channels to an application. A detailed explanation is
available in the section Object group: channels, variables.
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